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This guide explains how to use SMART Ink® with your SMART interactive product.

About SMART Ink
You can use SMART Ink to write and draw in digital ink over open applications, files, folders, websites 
and any other open window on your computer. When you move, resize or minimize a window, the ink 
stays with the window.

You can write over each tab in Internet Explorer® and Chrome™ Internet browsers or over a video 
without pausing it or interfering with the video’s interactivity. You can highlight content on the screen and 
move, copy and paste and erase digital ink notes or convert them to text. You can also capture notes as 
an image and save the image in a SMART software file.

When you open Microsoft® Word, Excel® or PowerPoint® in Windows® operating systems, you can use 
the Microsoft ink tools to write in files.

About other SMART software
SMART Ink and SMART Product Drivers are included with SMART Notebook® collaborative learning 
software and SMART Meeting Pro® software.

SMART Product Drivers
SMART Product Drivers enables your computer to detect input from SMART interactive products.

SMART Ink works with SMART Product Drivers to give you the ability to write on the screen with the 
interactive product’s pens using the drawing tools in the SMART Ink floating toolbar.
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SMART Notebook software
SMART Notebook software is designed for education users.

Using your SMART interactive product’s pens and the drawing tools in the SMART Ink floating toolbar, 
you can write in SMART Notebook software, and the digital ink becomes part of the SMART Notebook 
file.

SMART Meeting Pro software
SMART Meeting Pro software is designed for business users.

Using your SMART interactive product’s pens and the drawing tools in the SMART Ink floating toolbar, 
you can write in SMART Meeting Pro software, and the digital ink becomes part of the SMART 
Meeting Pro file.

Other resources
For more information about SMART Ink and the other SMART software on your computer, refer to the 
support pages on SMART’s website (smarttech.com/support). The support pages include all the 
information in this guide. You can view the support pages on your SMART interactive product or on a 
mobile device.

https://www.smarttech.com/support
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Use SMART Ink to write and draw in digital ink.

Using the dynamic (floating) toolbar

Opening the dynamic (floating) toolbar
Before opening the toolbar, connect your computer to a SMART interactive product and then start 
SMART Ink.

SMART Board interactive flat panels use Pen ID™. If you pick up a pen, the floating toolbar appears. 

The toolbar changes color based on the most-recently picked up pen tool. If you pick up the black pen 
first, the toolbar will be black; if you then pick up the red pen, it will change to red.

Note 

If the toolbar is currently expanded (i.e. someone has touched the floating toolbar center icon), the Ink 
software interprets this behavior as a potential change in pen properties, so even if other pens touch 
the board during this time, the center of the toolbar won't be updated.
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Users can choose the colors and other settings for their pens independently.

The procedure for opening the toolbar depends on the type of SMART interactive product you’re using.

Note 

You can set the toolbar to appear on screen at all times (see Chapter 5 Changing SMART Ink settings 
on page 53).

Viewing the toolbar in full mode
When you first open the toolbar, it appears minimized. To view the toolbar in full mode, tap it.

Notes 

 l If SMART Notebook software is installed, buttons for the first four SMART Ink Favorites appear 
around the toolbar when it’s minimized. These buttons are called “quick favorites” (see Saving 
and using favorite tools on page 24).

 l The options available in full mode depend on the type of SMART interactive product connected to 
your computer.

The toolbar minimizes after 10 seconds of non-use. You can also minimize the toolbar at any time by 
pressing its center.

Moving and docking the toolbar
If the toolbar is covering content, drag it to a different part of the screen.

You can dock the toolbar to the left or right edge of the screen by dragging it to that edge. You can also 

tap the docking button  in the top-right corner of the toolbar.

Pinning palettes in the toolbar
When you tap one of the buttons in the toolbar’s circle, the button moves to the top of the circle and a 
palette for the button appears. After 10 seconds of non-use, the toolbar minimizes and open palettes 
disappear.
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You can pin a palette so that it remains open while you write or draw or complete other tasks. To pin a 

palette, tap   in its upper-right corner. To unpin the palette, tap   in its top-right corner.

Note 

If you tap the center of the toolbar, the toolbar minimizes and pinned palettes disappear.

Closing (hiding) the toolbar
Unless the toolbar is set to appear at all times (see Chapter 5 Changing SMART Ink settings on page 53), 
it disappears when you return the pen to its holder. If you pick up the pen later, the toolbar reappears in 
the same location.

You can also hide the toolbar in other ways:

 l Dock the toolbar, push it off the screen until it disappears, and then tap Close Ink when prompted.

 l Tap  in the notification area (Windows operating systems) or Mac menu bar (OS X operating 
system software) and select Hide Ink Toolbar.

Note 

You can also turn off SMART Ink for a specific window or application (see Turning SMART Ink on or off 
on page 37).

Getting started with the SMART Touch Inking Tool
SMART Notebook software required

If your computer is connected to a SMART interactive product that supports touch recognition, you can 
use the SMART Touch Inking Tool to write or draw with your finger or an accessibility aid, such as a tennis 
ball.

Note 

The SMART Touch Inking Tool is available only if SMART Notebook software is installed.
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Starting the SMART Touch Inking Tool
You can start the SMART Touch Inking Tool in a variety of ways:

Operating system Options

Windows Select SMART Touch Inking Tool from the Windows Start menu.

Note 

This procedure varies depending on the version of the Windows operating 
system you’re using and your system preferences.

OS X  l Tap  in the Mac menu bar, and then select Show SMART Touch Inking 
Tool.

 l Open the SMART Ink Settings window, tap Toolbar Settings, and then tap 
Start SMART Touch Inking Tool (see Changing settings in Mac operating 
system software on page 58).

Note 

If the SMART Touch Inking Tool isn’t available for your SMART interactive product, a message informs 
you when you try to open the tool.

Using the SMART Touch Inking Tool
After you start the SMART Touch Inking Tool, its floating toolbar 
appears. The SMART Touch Inking Tool toolbar is identical to the 
SMART Ink toolbar except that its circle is blue rather than gray (see 
Using the dynamic (floating) toolbar on page 6).

 

The SMART Touch Inking Tool toolbar lets you do everything that you can do with your SMART 
interactive product’s pens and erasers, but with your finger or an accessibility aid, such as a tennis ball:

 l Write, draw and erase

 l Save digital ink in a screen capture

 l Convert handwriting to typed text

 l Save and use SMART Ink Favorites
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Closing the SMART Touch Inking Tool
You can close the SMART Touch Inking Tool in a number of ways:

Operating system Options

All   Dock the SMART Touch Inking Tool toolbar, push it off the screen until it 
disappears, and then tap Close Ink when prompted.

Windows  l Tap  in the notification area, and then select Hide SMART Touch 
Inking Tool.

 l Open the SMART Ink Settings window, tap Toolbar Settings, and then tap 
Close SMART Touch Inking Tool (see Changing settings in Windows 
operating systems on page 53).

OS X  l Tap  in the Mac menu bar, and then select Hide SMART Touch 
Inking Tool.

 l Open the SMART Ink Settings window, tap Toolbar Settings, and then tap 
Close SMART Touch Inking Tool (see Changing settings in Mac operating 
system software on page 58).

Note 

You can also turn off the SMART Touch Inking Tool for a specific window or application (see Turning 
SMART Ink on or off on page 37).

Writing, drawing, and erasing
When you write or draw in an application or on the desktop, the digital ink becomes an object that you 
can erase, move and otherwise manipulate.

In addition to writing or drawing in various types of digital ink, you can write or draw in disappearing 
digital ink and draw spotlights, magnifiers and shapes.

Note 

You can write in, draw in, erase and manipulate digital ink when SMART Ink is running (see Using the 
dynamic (floating) toolbar on page 6) and your computer is connected to a SMART interactive 
product.

Writing and drawing in digital ink
You can write or draw in most applications and on the desktop.
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Note 

If you are writing or drawing in a Microsoft Office application, see Chapter 3 Using SMART Ink with 
Microsoft Office on page 40.

 

To write or draw in digital ink

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap  , and then select one of the following pens:

Icon Name

Standard pens

Pen

Highlighter

Calligraphic pen

SMART Notebook pens1

Crayon

Creative pen

Text pen1

Paint brush

Note 

For information on the magic pen and shape recognition pen, see Writing and drawing in 
disappearing digital ink on page 13, Drawing spotlights on page 14, and Drawing magnifiers on 
page 15.

1These pens are available only if SMART Notebook software is installed.
1The text pen behaves like the standard pen outside of SMART Notebook software.
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 4. Set the color and line properties for the pen:

Property

Color Yes Yes Yes Yes Yes1 Yes Yes

Line style Yes No No No No No No

Line start Yes No No No No No No

Line end Yes No No No No No No

Thickness Yes Yes Yes Yes Yes Yes Yes

Transparency Yes No Yes No No Yes No

 5. Write or draw in digital ink.

Note 

When you write or draw in digital ink on the desktop, the digital ink appears inside a 
SMART Ink Note. You can move and close the SMART Ink Note as you would any other window.

Using personal creative pens
If SMART Notebook software is installed, you can use photographs or other picture files to create 

personal creative pens.

To add a personal creative pen

 1. Save the Bitmap, GIF, JPEG, PNG or TIFF picture file you want to use for a personal creative pen in a 
location you can access from the computer on which SMART Ink is installed.

 2. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 3. Tap  .

 4. Tap  , and then select  .

1Presets, rather than color options, are available for the creative pen.
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 5. Tap  .

 6. Tap  .

The Open dialog box appears.

 7. Browse to the picture file you saved in step 1, and then tap Open.

SMART Ink adds a creative pen based on the picture file.

To delete a personal creative pen

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap  , and then select  .

 4. Tap  .

 5. Tap and hold the personal creative pen, and then tap Delete.

Writing and drawing in disappearing digital ink
If SMART Notebook software is installed, you can use the magic pen to write or draw in digital ink that 

disappears after a few seconds.

To write or draw in disappearing digital ink

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap  , and then select  .

 4. Set the color and line thickness for the magic pen.
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 5. Write or draw in digital ink using the magic pen.

The digital ink disappears after a few seconds.

Drawing spotlights
If SMART Notebook software is installed, you can create a spotlight to highlight content on the screen. 

You do this by drawing a circle or oval using the magic pen.

To draw a spotlight

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap  , and then select .

 4. Set the color and line thickness for the magic pen.

 5. Draw a circle or oval around the portion of the screen you want to display using the magic pen.

A spotlight appears.
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 6. Optionally, press the spotlight’s edge, and then drag outward or inward to make the spotlight larger 
or smaller.

 7. When you’re done with the spotlight, tap  .

Tip 

Alternatively, you can open the Spotlight tool from the toolbox (see Using the Spotlight tool on 
page 34).

Drawing magnifiers
If SMART Notebook software is installed, you can magnify content on the screen by drawing a square 

or rectangle with the magic pen.

To draw a magnifier

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap  , and then select  .

 4. Set the color and line thickness for the magic pen.

 5. Use the magic pen to draw a square or rectangle around the portion of the screen you want to 
magnify.

A magnifier appears.
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 6. Optionally, do the following:

 o Tap within the magnifier and then drag to move it.

 o Tap the magnifier’s edge, and then drag outward or inward to make the magnifier 
larger or smaller.

 o Drag the slider below the magnifier to zoom in and out.

 7. When you’re done with the magnifier, tap  .

Tip 

Alternatively, you can open the Magnifier tool from the toolbox (see Using the Magnifier tool on 
page 35).

Drawing shapes
If SMART Notebook software is installed, you can use the shape recognition pen to draw circles, ovals, 

squares, rectangles, triangles and arcs. SMART Ink converts your drawings to the appropriate shapes.

Note 

In SMART Notebook software, the shapes are converted to SMART Notebook software objects. In 
other applications and on the desktop, the shapes remain digital ink.
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To draw a shape

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap  , and then select  .

 4. Set the color and line thickness for the shape recognition pen.

 5. Draw a shape using the shape recognition pen.

If SMART Ink recognizes your drawing as a circle, oval, square, rectangle, triangle or arc, it converts 
the drawing to that appropriate shape.

Erasing
The procedure for erasing digital ink depends on the type of SMART interactive product that you’re 
using:

Interactive product(s) Procedure

Interactive displays

SMART Board 7000   Move the eraser end of a pen over the digital ink you want to erase.
OR
Move your palm or fist over the digital ink you want to erase. 
OR
Move the eraser over the digital ink you want to erase.

SMART Board 8000i-G5   Move the eraser end of a pen over the digital ink you want to erase.
OR
Move your palm or fist over the digital ink you want to erase.

SMART Board 8000i-G4
SMART Board 8000i-G3

  Move the eraser over the digital ink you want to erase.
OR
Move your palm or fist over the digital ink you want to erase.

SMART Board 6000   Move the eraser end of a pen over the digital ink you want to erase.
OR
Move your palm or fist over the digital ink you want to erase.
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Interactive product(s) Procedure

SMART Board 4000  1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see 
Opening the dynamic (floating) toolbar on page 6).
OR
Open the SMART Touch Inking Tool dynamic toolbar in full mode (see 
Starting the SMART Touch Inking Tool on page 9).

 2. Tap  , and then select an eraser size.
 3. Move your finger over the digital ink you want to erase.

Interactive whiteboards

SMART Board 800   Move the eraser over the digital ink you want to erase.
OR
Move your palm or fist over the digital ink you want to erase.

SMART Board M600  1. Tap the Eraser button on the pen tray.
OR
Do the following:
 a. Open the toolbar in full mode (see page 6).

 b. Tap  , and then select an eraser size.
 2. Move your finger over the digital ink you want to erase.

SMART Board 600   Move the eraser over the digital ink you want to erase.
OR
Move your palm or fist over the digital ink you want to erase.

Other interactive products

LightRaise® 60wi2
LightRaise 60wi

 1. Open the SMART Ink toolbar in full mode (see page 6).

 2. Tap  , and then select an eraser size.
 3. Move your finger over the digital ink you want to erase.

SMART Podium™  1. Tap the Eraser button on the interactive pen display.

 2. Move the tethered pen over the digital ink you want to erase.

Writing, drawing or erasing at the same time as another user
On the following SMART interactive products, two users can write, draw and erase at the same time:

 l SMART Board 7000 series interactive displays

 l SMART Board 8000i-G5 series interactive flat panels

 l SMART Board 8000i-G3 and 8000i-G4 series interactive flat panels

 l SMART Board 6000 series interactive flat panels
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 l SMART Board 4000 series interactive flat panels

 l SMART Board 800 series interactive whiteboards

 l SMART Board M600 series interactive whiteboards

 l LightRaise 60wi and 60wi2 interactive projectors

SMART Board 7000 series interactive displays, 6000 series and 8000i-G5 series interactive flat panels 
have Pen ID, which enables:

 l Two users to specify colors and other settings for their pens independently on the 6000 series and 
8000i-G5 series interactive flat panels.

 l Four users to specify colors and other settings for their pens independently on the 7000 series 
interactive displays.

Manipulating digital ink
You can manipulate digital ink objects that you created with SMART Ink.

To select an object

  Tap the object once.

A border appears around the object.
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To select multiple objects

 1. Tap the first object once.

A border appears around the object.

 2. Tap   on the border.

 3. Drag a rectangle around the objects you want to select.

To select all objects

 1. Tap the first object once.

A border appears around the object.

 2. Tap the arrow  on the border, and then select Select All.

To clear the selection of objects

  Tap the arrow  on the border, and then select Select None.
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To move objects

 1. Select the objects.

 2. Drag the objects to a new location.

Tip 

You can also flick the objects to move them quickly.

To cut or copy and then paste objects

 1. Select the objects.

 2. Tap the arrow  on the border, and then select Cut or Copy.

 3. Paste the objects in another application.

To delete objects

 1. Select the objects.

 2. Tap   on the border.

Tip 

You can also erase digital ink to delete it (see Erasing on page 17).

Saving and clearing digital ink
Use the screen capture tool to save digital ink annotations, or clear all the annotations you made with 
SMART Ink.

Note 

Screen capture support is available only if SMART Notebook software or SMART Meeting Pro software 
are installed on your computer.

After taking the screen capture, you can choose from a variety of actions:

 l Send the screen capture to a new page in SMART Notebook software or SMART Meeting Pro 
software.

 l Send the screen capture to the current page in SMART Notebook software.

Note 

This option is available when SMART Notebook software is open.
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 l Save the screen capture as a PNG file to a folder named Capture on the desktop.

 l Save the screen capture as a PNG file to a location of your choosing.

 l Leave the screen capture on the clipboard to paste into any application.

You can clear digital ink from a window or SMART Ink Note after saving it.

Note 

To take a screen capture or clear digital ink, start SMART Ink (see Using the dynamic (floating) toolbar 
on page 6) and connect your computer to a SMART interactive product.

Taking screen captures

To take a screen capture using the Capture toolbar

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  , and then tap  .

 3. Tap one of the following buttons:

Button Description

Capture a rectangular area.

Capture a window.

Capture an entire screen.

Capture a freehand area.

 4. Select the area, window or screen you want to capture.

The Capture window opens. This window displays a thumbnail of the screen capture and a button 
for the last action you selected.

 5. Tap the last action’s button.

OR

Tap Do something else and select a different action.
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To take a screen capture using SMART Ink window tools

 1. Write or draw digital ink over a window or on the desktop (see Writing, drawing, and erasing on 
page 10).

 2. Tap the SMART Ink window tools button  in the top-right corner of the window or SMART Ink Note, 
and then select Capture Ink.

The Capture window opens. This window displays a thumbnail of the screen capture and a button 
for the last action you selected.

 3. Tap the last action’s button.

OR

Tap Do something else and select a different action.

Clearing all digital ink from a window or SMART Ink Note
As an alternative to erasing digital ink, you can clear all digital ink from a window or SMART Ink Note.

To clear all digital ink from a window or SMART Ink Note

  Tap  in the upper-right corner of the window or the SMART Ink Note, and then select Clear Ink.

Notes

 o In Internet Explorer and Chrome for Windows , this procedure clears digital ink from the 
current tab. Digital ink in other tabs is not affected.

 o In Chrome for macOS a software, this procedure clears digital ink from all tabs in the 
Chrome window. 

Converting handwriting to typed text
You can write in digital ink and then convert the writing to text. For example, you can write over a 
browser and then insert the ink as text in the browser’s search field.

Note 

You can convert handwriting to text outside of SMART software when SMART Ink is running (see Using 
the dynamic (floating) toolbar on page 6) and your computer is connected to a SMART interactive 
product.
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To convert new handwriting

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  , and then tap  .

The text conversion window appears.

 3. Write the characters you want to convert to text in the text conversion window.

As you write, the text conversion window converts your handwriting to text.

Notes 

 o To display an on-screen keyboard, tap  .

 o To remove existing text from the text conversion window, tap  .

 o To edit text, use the editing marks in the bottom left corner of the text conversion window.

 4. If you want to insert the text in the application, tap  , and then tap where you want to insert the 
text.

OR

If you don’t want to insert the text in the application, tap  .

To convert existing handwriting

 1. Select the handwriting you want to convert.

 2. Tap   on the border.

A message appears asking you to touch where you want to insert this text, and your converted 
writing appears.

 3. Tap the location in an application where you want to insert the text.

Your notes appear in the application as text.

Saving and using favorite tools
SMART Notebook software required
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You can save pens, stamps, and tools as SMART Ink Favorites for easy access.

Notes 

 l SMART Ink Favorites are available only if SMART Notebook software is installed on your 
computer.

 l To use SMART Ink Favorites, start SMART Ink (see Using the dynamic (floating) toolbar on page 6) 
and connect your computer to a SMART interactive product.

Using favorite pens
If you frequently write or draw in the same color, width and style of digital ink, you can save those 
properties as a favorite pen.

To add a favorite pen

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap  , and then select Pen.

 4. Select a favorite pen type.

 5. Set the favorite pen’s properties.

 6. Tap Add as favorite.

To edit a favorite pen

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap Edit.

 4. Select the favorite pen, and then tap Customize Pen.
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 5. Change the favorite pen’s properties.

 6. Tap Save.

To delete a favorite pen

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap Edit.

 4. Select the favorite pen, and then tap Delete.

 5. Tap Done.

To write or draw in digital ink using a favorite pen

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Select a quick favorite by pressing it.

OR

Tap  , and then select the favorite pen.

Note 

If you’re using a SMART Board interactive flat panel and the  SMART Touch Inking Tool is not 
available, the toolbar is used in full mode to access the Favorites button.

 3. Write or draw in digital ink.
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Using favorite stamps
If you frequently use a stamp from the stamp pad, you can save the stamp as a favorite stamp.

To add a favorite stamp

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap  , and then select Stamp.

 4. Select the stamp you want to save as a favorite.

 5. Tap Add as favorite.

To delete a favorite stamp

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap .

 3. Tap Edit.

 4. Select the favorite stamp, and then tap Delete.

 5. Tap Done.

To use a favorite stamp

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).
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 2. Select a quick favorite by pressing it.

OR

Tap  , and then select the favorite stamp.

Note 

If you’re using a SMART Board interactive flat panel and the  SMART Touch Inking Tool is not 
available, the toolbar is used in full mode to access the Favorites button.

 3. Tap where you want to insert the stamp.

Using favorite tools
If you frequently use a tool from the toolbox, you can save the tool as a favorite tool.

To add a favorite tool

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap  , and then select Tool.

 4. Select the tool you want to save as a favorite.

 5. Tap Add as favorite.

To delete a favorite tool

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .
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 3. Tap Edit.

 4. Select the favorite tool, and then tap Delete.

 5. Tap Done.

To use a favorite tool

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Select a quick favorite by pressing it.

OR

Tap  , and then select the favorite tool.

Note 

If you’re using a SMART Board interactive flat panel and the  SMART Touch Inking Tool is not 
available, the toolbar is used in full mode to access the Favorites button.

 3. Use the favorite tool (see Saving and clearing digital ink on page 21, Converting handwriting to 
typed text on page 23, or Using presentation tools on page 33).

Changing the order of SMART Ink Favorites
Buttons for the first four SMART Ink Favorites appear around the toolbar when it’s minimized. These 
buttons are called “quick favorites.”

You can change the order of SMART Ink Favorites so that your preferred SMART Ink Favorites are quick 
favorites.
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To change the order of SMART Ink Favorites

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap Edit.

 4. Select a SMART Ink Favorite, and then drag it from its current position in the palette to a new 
position.

 5. Repeat step 4 for each SMART Ink Favorite you want to move.

 6. Tap Done.

Using the stamp pad
SMART Notebook software required

You can use the SMART Ink stamp pad to reinforce ideas, correct student work, reward student 
achievements, and so on. You can erase and manipulate stamps as you do digital ink (see Writing, 
drawing, and erasing on page 10).

The stamp pad comes with ten standard stamps. You can also create your own personal stamps.

Notes 

 l The stamp pad is available only if SMART Notebook software is installed on your computer.

 l To use the stamp pad, start SMART Ink (see Using the dynamic (floating) toolbar on page 6) and 
connect your computer to a SMART interactive product.
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Inserting stamps

To insert a stamp

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  , and then tap  .

 3. Select a stamp.

 4. Tap where you want to insert the stamp.

The stamp’s appearance depends on the applications you’re stamping:

Application Appearance

SMART Notebook software Creative pen digital ink

PowerPoint presentation Black pen digital ink

Note 

The stamp pad is not available for PowerPoint presentation on a 
Windows computer.

SMART Ink Document 
Viewer

Black pen digital ink

Note 

The stamp pad is not available for SMART Ink Document Viewer 
on a Windows computer.

Desktop and all other 
applications

Stamp

Note 

If you insert a stamp on the desktop, the stamp appears inside a 
SMART Ink Note. You can move and close the SMART Ink Note as 
you would any other window.

Inserting stamps at the same time as another user
On the following SMART interactive products, two users can insert stamps at the same time:

 l SMART Board 7000 series interactive displays

 l SMART Board 8000i-G5 series interactive flat panels
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 l SMART Board 8000i-G3 and 8000i-G4 series interactive flat panels

 l SMART Board 6000 series interactive flat panels

 l SMART Board 4000 series interactive flat panels

 l SMART Board 800 series interactive whiteboards

 l SMART Board M600 series interactive whiteboards

 l LightRaise 60wi interactive projectors

SMART Board 7000 series interactive displays, 6000 series and 8000i-G5 series interactive flat panels 
have Pen ID, which enables: 

 l Two users to specify different stamps for their pens on the 6000 series and 8000i-G5 interactive flat 
panels.

 l Four users to specify different stamps for their pens on the 7000 series interactive displays.

Using personal stamps
You can use photographs or other picture files as your own personal stamps.

To add a personal stamp

 1. Save the GIF, JPEG, PNG or TIFF picture file you want to use for a personal stamp in a location you 
can access from the computer on which SMART Ink is installed.

 2. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 3. Tap  , and then tap  .

 4. Tap  .

The Open dialog box appears.

 5. Browse to the picture file you saved in step 1, and then tap Open.

SMART Ink adds a personal stamp based on the picture file.
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To delete a personal stamp

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  , and then tap  .

 3. Tap and hold the personal stamp, and then tap Delete.

Using presentation tools
You can use the following tools when presenting content on a SMART interactive product:

 l Spotlight

 l Magnifier

 l Screen Shade

Note 

To use presentation tools, start SMART Ink (see Using the dynamic (floating) toolbar on page 6) and 
connect your computer to a SMART interactive product.
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Using the Spotlight tool
You can use the Spotlight tool during a presentation to draw attention to an area of a screen:

To use the Spotlight tool

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  , and then tap  .

Tip 

Alternatively, you can open the Spotlight tool from the Start menu (Windows operating systems) 
or the Finder (OS X operating system software).

 3. Optionally, tap the spotlight’s edge, and then drag outward or inward to make the spotlight larger 
or smaller.
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 4. When you’re done with the Spotlight tool, tap  .

Tip 

Alternatively, you can create a spotlight using the magic pen (see Drawing spotlights on page 14).

Using the Magnifier tool
You can use the Magnifier tool to magnify content on a screen.

To use the Magnifier tool

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  , and then tap  .

 3. Optionally, do the following:

 o Tap within the magnifier and then drag to move it.

 o Tap the magnifier’s edge, and then drag outward or inward to make the magnifier 
larger or smaller.

 o Drag the slider below the magnifier to zoom in and out.
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 4. When you’re done with the Magnifier tool, tap  .

Tip 

Alternatively, you can create a magnifier using the magic pen (see Drawing magnifiers on 
page 15).

Using the Screen Shade tool
You can use the Screen Shade tool to cover a screen and reveal its content slowly:
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To use the Screen Shade tool

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  , and then tap  .

Tip 

Alternatively, you can open the Screen Shade tool from the Start menu (Windows operating 
systems) or the Finder (OS X operating system software).

 3. Tap one side of the screen shade and drag it to cover and uncover the display’s screen.

Tips 

 o Tap the screen shade to change its color.

 o Double-click the screen shade to resume covering the entire screen.

 4. When you’re done with the Screen Shade tool, tap  .

Turning SMART Ink on or off
You can use SMART Ink to write or draw on most windows. However, there may be times where you wish 
to turn off SMART Ink. You can turn off SMART Ink in the following ways:

Turn off SMART Ink 
temporarily for all 
windows/applications

If you don’t need to use SMART Ink, you can disable it until the next time you 
restart or log in to the computer.

Tip 

If you want to leave SMART Ink on, but hide the dynamic (floating) toolbar, 
see Closing (hiding) the toolbar on page 8.

Turn off SMART Ink for 
a specific window

If you want to turn off SMART Ink for a specific application window, use this 
option.

Turn off SMART Ink 
permanently for an 
application

This is particularly useful when an application has its own writing and drawing 
tools (for example, Microsoft Word or PowerPoint) that you want to use 
instead of SMART Ink.

Note 

SMART Ink is for use with an interactive product. If the computer on which SMART Ink is installed is not 
connected to an interactive product, such as a SMART Board, you cannot use SMART Ink.
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Turning off SMART Ink

To turn off SMART Ink temporarily for all windows and applications

 1. Tap  in the notification area (Windows operating systems) or Mac menu bar (OS X operating 
system software) and select SMART Settings.

 2. Tap SMART Ink Settings.

 3. Confirm the Start SMART Ink when you log on box is selected.

 4. Tap Turn Off SMART Ink.

Note 

SMART Ink is still available in SMART Notebook or Meeting Pro software.

To turn off SMART Ink for a window

 1. Write or draw in the window (see Writing, drawing, and erasing on page 10).

Note 

To turn off SMART Ink for a window or an application, start SMART Ink (see Using the dynamic 
(floating) toolbar on page 6) and connect your computer to a SMART interactive product.

 2. Tap  in the top-right corner of the window, and then select Turn off SMART Ink.

The Turn off SMART Ink dialog box appears.

 3. Tap In this window.

 4. Writing or drawing with SMART Ink no longer works in the window.

To turn off SMART Ink for an application

 1. Write or draw in the window (see Writing, drawing, and erasing on page 10).

 2. Tap  in the top-right corner of the application, and then select Turn off SMART Ink.

The Turn off SMART Ink dialog box appears.
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 3. Tap In this application.

Writing or drawing with SMART Ink no longer works in the application.

Important 

This is a permanent change. If you turned off SMART Ink for an application by accident, you can 
turn it back on. For more information, see Enabling SMART Ink on specific applications 
(community.smarttech.com/s/article/Enabling-SMART-Ink-on-specific-applications).

Turning on SMART Ink manually
By default, SMART Ink starts when you first log on to your computer. However, if SMART Ink isn’t set up to 
start automatically, you can start it manually.

After SMART Ink starts, you can open the SMART Ink dynamic (floating) toolbar and use it to write and 
draw, convert handwriting to text, take screen captures and use favorites. 

To start SMART Ink manually in Windows operating systems

  Select SMART Ink  the Windows Start menu.

Note 

This procedure varies depending on the version of the Windows operating system you’re using 
and your system preferences.

To start SMART Ink manually inMac operating system software software

  In Finder, go to Applications/SMART Technologies and double-click SMART Ink.

https://community.smarttech.com/s/article/Enabling-SMART-Ink-on-specific-applications
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SMART Ink includes plug-ins that enable you to use the software with Microsoft Office applications.

Note 

This chapter applies to Windows operating systems only.

Writing and drawing in Microsoft Word, Excel and 
PowerPoint
Microsoft Word, Excel and PowerPoint have their own ink tools. You can enable these ink tools in 
SMART Ink Settings (see Changing settings in Windows operating systems on page 53).

The following table compares Microsoft’s ink tools and SMART Ink:

Category Microsoft’s ink tools SMART Ink

Purpose Reviewing or making changes to a 
document

Highlighting important notes or 
drawing attention to content in a 
document

How ink is 
captured

Ink is inserted directly in your document. Ink is captured in a transparent layer 
over your document.

How to save ink The inserted ink is saved with the 
document.

Take a screen capture and save it using 
SMART software (see page 21).
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To write or draw using Microsoft’s ink tools

 1. Open SMART Ink’s dynamic (floating) toolbar in full mode (see Opening the dynamic (floating) 
toolbar on page 6).

OR

Open the SMART Touch Inking Tool dynamic toolbar in full mode (see Starting the SMART Touch 
Inking Tool on page 9).

 2. Tap  .

 3. Tap Open Office® Ink Tools.

The Ink Tools ribbon appears.

Note 

If the Open Office® Ink Tools doesn’t appear, Microsoft’s ink tools might be disabled (see To 
change Microsoft Office settings on page 55).

 4. Select a pen and set properties using the Ink Tools ribbon.

 5. Write or draw in digital ink.

Using SMART Ink during PowerPoint presentations
The SMART Ink Toolbar for PowerPoint appears when you start a PowerPoint presentation if the 
following are true:

 l SMART Ink is running.

 l Your computer is connected to a SMART interactive product.

 l The SMART Ink plug-in for PowerPoint is enabled.

 l The SMART Ink Toolbar for PowerPoint is enabled (see Chapter 5 Changing SMART Ink settings on 
page 53).

Moving the SMART Ink Toolbar for PowerPoint
The SMART Ink Toolbar for PowerPoint appears in the lower-left corner of the screen by default. You can 
move it by dragging it to a new location.
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Displaying slides
You can use the SMART Ink Toolbar for PowerPoint to select the previous or next slide in your 
presentation. You can also insert a new, blank slide.

To display the previous slide

  Tap  .

To display the next slide

  Tap  .

To insert a new, blank slide

 1. Tap  .

 2. Tap  , and then tap .

Writing or drawing in digital ink
You can use the SMART Ink Toolbar for PowerPoint to write or draw in your presentation.

To write or draw in digital ink

 1. Tap  .

 2. Tap   and, optionally, select a line color and thickness.

 3. Write or draw in digital ink.

To highlight content

 1. Tap  .

 2. Tap   and, optionally, select a highlighter color.

 3. Highlight content.

To clear digital ink

 1. Tap  .

 2. Tap  , and then tap  .
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Ending your presentation
You can use the SMART Ink Toolbar for PowerPoint to end your presentation.

To end your presentation

  Tap  .
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You can write or draw in PDF files using the following tools:

 l SMART Ink plugin for Adobe Acrobat Reader (Windows operating systems only)

 l SMART Ink Document Viewer

Using the SMART Ink plugin for 
Adobe Acrobat Reader

Windows operating systems only

If you installed SMART Ink on a computer with Adobe Reader XI or Adobe Acrobat Reader DC, you can 
use the SMART Ink plugin for Adobe Acrobat Reader to write or draw in PDF files.

Tip 

To confirm that the SMART Ink plugin is installed, go to Adobe Acrobat Reader and select Help > 
About Third-Party Plug-Ins > About SMART Ink plugin.

Writing in, drawing in and erasing digital ink
With Adobe Acrobat Reader and the SMART Ink plugin, you can write in, draw in and erase digital ink in 
PDF files. The SMART Ink plugin inserts digital ink in the PDF file as Adobe Acrobat Reader comments.
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To write or draw in a PDF file

 1. Open the PDF file in Adobe Acrobat Reader.

Note 

If the author has restricted editing of the PDF file, a message appears. Ask the author to permit 
editing of the PDF file so that you can write or draw in it.

 2. Use your SMART interactive product’s pen and the SMART Ink floating toolbar to write or draw in 
the PDF file (see Writing, drawing, and erasing on page 10).

To erase digital ink in a PDF file

  Use your SMART interactive product’s eraser, your palm, your fist or the SMART Ink floating toolbar 
to erase digital ink in the PDF file (see Writing, drawing, and erasing on page 10).

Labeling digital ink
You can label digital ink in situations where more than one person is writing or drawing in a PDF file. You 
can also use labels to differentiate digital ink notes. For example, in an architectural drawing, you could 
distinguish notes related to electrical systems from those related to plumbing systems.

To create a label

 1. Open the PDF file in Adobe Acrobat Reader.

 2. Pick up your SMART interactive product’s pen.

 3. Click  .

 4. Tap  .

The text conversion window appears.

 5. Write the text for the label in the text conversion window.

As you write, the text conversion window converts your handwriting to text.

Notes 

 o To display an on-screen keyboard, tap  .

 o To remove existing text from the text conversion window, tap  .

 o To edit text, use the editing marks in the bottom left corner of the text conversion window.

 6. Tap  .
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To delete a label

 1. Open the PDF file in Adobe Acrobat Reader.

 2. Pick up your SMART interactive product’s pen.

 3. Click  .

 4. Select the label, and then tap  .

To label digital ink

 1. Open the PDF file in Adobe Acrobat Reader.

 2. Pick up your SMART interactive product’s pen.

 3. Click  , and then select a label.

 4. Write or draw in the PDF file.

The SMART Ink plugin applies the selected label to the digital ink.

Using the SMART Ink Document Viewer for 
Windows computers

Windows operating systems only

SMART Ink Document Viewer is available on your computer if you installed SMART Ink with 
SMART Notebook software or SMART Meeting Pro software.
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Getting started with the SMART Ink Document Viewer
You can use the SMART Ink Document Viewer to view PDF files and write or draw over them. You can 
also navigate within files, magnify pages and save and print files, including your ink notes.

Tip 

When you install SMART software, you can make SMART Ink Document Viewer the default PDF viewer. 
To use a different PDF viewer, right-click the PDF file and select Open with.

To start the SMART Ink Document Viewer

  Select SMART Ink Document Viewer from the Windows Start menu.

Note 

This procedure may vary depending on your version of Windows operating system and your 
system preferences.

To open a file

 1. Tap   .

The Open dialog box appears.

 2. Browse to and select the file you want to open.

 3. Tap Open.

To write with pen tools

 1. Pick up a pen from your interactive product’s pen tray.

OR

Tap an ink color button on your interactive pen display.

 2. Write over the open file.

Using the SMART Ink Document Viewer toolbar
The SMART Ink Document Viewer toolbar contains all the tools you need for viewing PDF files.

Toolbar button Description

Open

Save
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Toolbar button Description

Print

Open file in another program

Zoom in

Zoom out

Rotate page clockwise

Rotate page counterclockwise

% Zoom to a specific percentage

Previous page

Next page

4/10 Go to a specific page

Help

Information

Move toolbar

To move the toolbar

 1. Tap  .

A drop-down menu appears.

 2. Select Top, Bottom, Left or Right.

To zoom in or out

  Tap   or  .

To adjust the magnification and page view settings

 1. Tap  .

A drop-down menu appears.

 2. Select Fit Page, Fit Width, Two Page View or a magnification percentage.
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To display the previous page

  Tap  .

To display the next page

  Tap  .

To rotate the page

  Tap  to rotate the page 90° clockwise.

OR

Tap  to rotate the page 90° counterclockwise.

To save a file

 1. Tap  .

The Save As dialog box appears.

 2. Browse to the location where you want to save the file.

 3. Type a name for the file in the File name box.

 4. Tap Save.

Note 

If you made notes in the file, the digital ink is saved as a permanent part of the file. When you 
open the file again later, the ink cannot be modified.

To print a file

 1. Tap  .

The Print dialog box appears.

 2. Select your printer from the Printer drop-down menu.

 3. Optionally, adjust the Page Range, Page Scaling and Print Option settings.

 4. Tap Print.
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Using the SMART Ink Document Viewer for 
Mac computers
SMART Ink Document Viewer is available on your computer if you installed SMART Ink with 
SMART Notebook software.

Getting started with the SMART Ink Document Viewer
You can use the SMART Ink Document Viewer to view PDF files and write or draw over them. You can 
also navigate within files, magnify pages and save and print files, including your ink notes.

To start the SMART Ink Document Viewer

 1. In Finder, go to Applications/SMART Technologies.

 2. Double-click SMART Ink Document Viewer.

To open a file

 1. Select File > Open.

The Open dialog box appears.

 2. Browse to and select the file you want to open.

 3. Tap Open.

Using the SMART Ink Document Viewer

To write with  pen tools

 1. Pick up a pen from your interactive product’s pen tray.

OR

Tap an ink color button on your interactive pen display.

 2. Write over the open file.

Tip 

You can use SMART software to change ink properties.
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To zoom in or out

  Tap   or  .

Tip 

 o To return to the default magnification, tap  .

 o To zoom in on a portion of the document, tap  , and then drag over the portion of the 
document.

To adjust the page view settings

 1. Select PDF > PDF Display.

 2. Select the options you want to enable and clear the selection of the options you want to disable.

To display the previous page

  Tap Go to Previous Page .

To display the next page

  Tap Go to Next Page .

To rotate the page

  Select Tools > Rotate Left.

OR

Select Tools > Rotate Right.

To save a file

 1. Select File > Save As.

A dialog box appears.

 2. Type a name for the file in the Save As box.

 3. Select a location for the file in the Where drop-down list.

 4. Tap Save.

Note 

If you made notes in the file, the digital ink is saved as a permanent part of the file. When you 
open the file again later, the ink cannot be modified.
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To print a file

 1. Select File > Print.

A dialog box appears.

 2. Select your printer from the Printer drop-down menu.

 3. Tap Print.
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Chapter 5 Changing SMART Ink 
settings

Changing settings in Windows operating systems 53
Changing settings in Mac operating system software 58

You can use the SMART Ink Settings window to change settings for SMART Ink.

Changing settings in Windows operating systems
 1. If the floating toolbar is open, tap   in the toolbar’s lower-right corner.

OR

If the toolbar isn’t open, select SMART Ink Settings in the Windows Start menu.

Note 

This procedure may vary depending on your version of Windows operating system and your 
system preferences.

The SMART Ink Settings window appears.

 2. Tap General Settings.

 3. Change settings:

Control Procedure Notes

Start SMART Ink 
when you log on

Select the check box to start 
SMART Ink automatically when you 
log on to the computer.

If you clear the check box, SMART Ink 
doesn’t start when you log on to the 
computer and you must start it 
manually before you can write or 
draw over applications or create 
SMART Ink Notes (see Using the 
dynamic (floating) toolbar on page 6).

Erase ink after it’s 
converted to text

Select the check box to erase ink after 
you insert it as text in an application.

[N/A]

SMART Ink Note 
opacity

Select 25%, 50% or 75% to see through 
SMART Ink Notes.

[N/A]
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 4. Tap Apply, and then tap OK.

To change floating toolbar settings

 1. If the floating toolbar is open, tap   in the toolbar’s lower-right corner.

OR

If the toolbar isn’t open, select SMART Ink Settings in the Windows Start menu.

Note 

This procedure may vary depending on your version of Windows operating system and your 
system preferences.

The SMART Ink Settings window appears.

 2. Tap Toolbar Settings.

 3. Change settings:

Control Procedure Notes

Reset Toolbar 
Positions

Tap Reset SMART Ink toolbars to 
their default positions to return 
floating toolbars to their original 
positions on the screen.

[N/A]

Always show pen 
toolbars

Select the check box to always display 
the floating toolbars when your 
computer is connected to a SMART 
interactive product.

Changes to this check box take effect 
after you restart SMART Ink.

SMART Touch 
Inking Tool

Tap Start SMART Touch Inking Tool 
to turn on the SMART Touch 
Inking Tool (see Getting started with 
the SMART Touch Inking Tool on 
page 8).
OR
Tap Close SMART Touch Inking Tool 
to turn off the SMART Touch 
Inking Tool.

This control is available only if your 
computer is connected to a SMART 
interactive product that supports 
touch recognition and if 
SMART Notebook software is installed 
on your computer.

 4. Tap Apply, and then tap OK.
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To change Microsoft Office settings

 1. If the floating toolbar is open, tap   in the toolbar’s lower-right corner.

OR

If the toolbar isn’t open, select SMART Ink Settings in the Windows Start menu.

Note 

This procedure may vary depending on your version of Windows operating system and your 
system preferences.

The SMART Ink Settings window appears.

 2. Tap Microsoft Office® Settings.
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 3. Change settings:

Control Procedure Notes

In Microsoft 
Office® Edit 
mode, use the 
following by 
default

Select Use SMART Ink so that my ink 
doesn’t permanently affect my 
content to use SMART Ink in Microsoft 
Office applications.
OR
Select Use Microsoft® Ink so that my 
ink is written and saved directly in 
my content to use Microsoft’s ink tools 
in Microsoft Office applications.

Choose SMART Ink if you want to write 
or draw ink over Microsoft Office 
documents for presentation purposes 
but don’t want to add the ink to the 
documents.
Choose Microsoft’s ink tools if you 
want to add the ink you write or draw 
to the Microsoft Office documents.

Enable the 
SMART 
PowerPoint® 
plug-in

Select the check box to enable the 
SMART Ink plug-in for PowerPoint.
OR
Clear the check box to disable the 
SMART Ink plug-in for PowerPoint.

[N/A]

Show the SMART 
Ink Toolbar for 
PowerPoint® in 
Presentation 
mode

Select the check box to display the 
SMART Ink Toolbar for PowerPoint in 
PowerPoint presentations.

This check box is available only if you 
enable the SMART Ink plug-in for 
PowerPoint.
If you clear this check box, you can still 
write or draw over slides and use 
navigation gestures in PowerPoint 
presentations.
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Control Procedure Notes

Use Presenter 
View when 
presenting 
PowerPoint® files 
on multiple 
displays

Select the check box if you want to 
use PowerPoint Presenter View when 
showing presentations.
OR
Clear the check box if you don’t want 
to use PowerPoint Presenter View 
when showing presentations.

This check box is available only if you 
enable the SMART Ink plug-in for 
PowerPoint.
If your computer is connected to 
multiple displays and you use 
PowerPoint Presenter View during a 
PowerPoint presentation, the 
PowerPoint slides appear on one 
display (usually a large display visible 
to all participants) and PowerPoint 
Presenter View appears on another 
display (usually a personal display 
visible only to the presenter). You can 
then control the presentation using 
PowerPoint Presenter View.
Because you’re unable to write or 
draw digital ink in PowerPoint 
Presenter View, SMART Ink disables 
this option by default.

Disable slide 
navigation 
gestures in 
Microsoft 
PowerPoint® 
Presentation 
mode

Select the check box to disable 
navigation gestures in PowerPoint 
presentations.

This check box is available only if you 
enable the SMART Ink plug-in for 
PowerPoint.
Disable navigation gestures to avoid 
triggering them accidentally when 
you brush an article of clothing or 
jewelry across the interactive surface.
If you disable navigation gestures, you 
can navigate presentations using on-
screen tools instead.

 4. Tap Apply, and then tap OK.
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Changing settings in Mac operating system 
software
 1. If the floating toolbar is open, tap   in the toolbar’s lower-right corner.

OR

If the toolbar isn’t open, go to Applications/SMART Technologies in Finder and double-click 
SMART Ink Settings.

The SMART Ink Settings window appears.

 2. Tap General Settings.

 3. Change settings:

Control Procedure Notes

Start SMART Ink 
when you log on

Select the check box to start 
SMART Ink automatically when you 
log on to the computer.

If you clear the check box, SMART Ink 
doesn’t start when you log on to the 
computer and you must start it 
manually before you can write or 
draw over applications or create 
SMART Ink Notes (see Using the 
dynamic (floating) toolbar on page 6).

Erase ink after it’s 
converted to text

Select the check box to erase ink after 
you insert it as text in an application.

[N/A]

Always show pen 
toolbars

Select the check box to always display 
the floating toolbars when your 
computer is connected to a SMART 
interactive product.

Changes to this check box take effect 
after you restart SMART Ink.

 4. Tap Apply, and then tap OK.
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To change floating toolbar settings

 1. If the floating toolbar is open, tap   in the toolbar’s lower-right corner.

OR

If the toolbar isn’t open, go to Applications/SMART Technologies in Finder and double-click 
SMART Ink Settings.

The SMART Ink Settings window appears.

 2. Tap Toolbar Settings.

 3. Change settings:

Control Procedure Notes

Restore Toolbar 
Positions

Tap Reset SMART Ink toolbars to 
their default positions to return 
floating toolbars to their original 
positions on the screen.

[N/A]

SMART Touch 
Inking Tool

Tap Start SMART Touch Inking Tool 
to turn on the SMART Touch 
Inking Tool (see Getting started with 
the SMART Touch Inking Tool on 
page 8).
OR
Tap Close SMART Touch Inking Tool 
to turn off the SMART Touch 
Inking Tool.

This control is available only if your 
computer is connected to a SMART 
interactive product that supports 
touch recognition and if 
SMART Notebook software is installed 
on your computer.

 4. Tap Apply, and then tap OK.
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This chapter explains how to troubleshoot common issues with SMART Ink.

Note 

This chapter applies to Windows operating systems only.

Using SMART Ink Settings to troubleshoot
Windows operating systems only

The SMART Ink Settings window includes a tab that lets you troubleshoot common issues with SMART Ink.

To use the troubleshooting tab

 1. If the floating toolbar is open, tap   in the toolbar’s lower-right corner.

OR

If the toolbar isn’t open, select SMART Ink Settings in the Windows Start menu.

Note 

This procedure may vary depending on your version of Windows operating system and your 
system preferences.

The SMART Ink Settings window appears.
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 2. Tap Troubleshooting.

SMART Ink verifies the following:

 o Is SMART Ink running?

 o Is your computer connected to a SMART interactive product?

 o Does your version of Windows operating system have inking tools?

 o Does your version of Microsoft Office have inking tools?

 o Are the SMART Ink plug-ins for PowerPoint, Word and Excel enabled (see Troubleshooting the 
SMART Ink plug-ins for Microsoft Office on page 63)?

If SMART Ink identifies an issue with any of the above points, it displays a red X beside the point and 
provides information about resolving the issue.

 3. Follow the on-screen instructions to resolve any issues.

Turning on Tablet PC components
Windows operating systems only

To enable all features of SMART Ink in Microsoft Office applications, turn on Tablet PC components. This 
procedure varies depending on your version of Windows operating system.

Important 

You might need to log in as an administrator to perform these procedures.

To turn on Tablet PC components in Windows 7 operating system

 1. Select Start > Control Panel.

The Control Panel appears.

 2. Select Category in the View by drop-down list.

 3. Tap Programs, and then tap Turn Windows features on or off.

The Windows Features dialog box appears.

Note 

You might be prompted to provide an administrator password or confirmation.

 4. Scroll to and select the Tablet PC Components check box.

 5. Tap OK.
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To turn on Tablet PC components in Windows 8.1 operating system

 1. Go to the Apps screen, and then scroll to and tap Control Panel.

The Control Panel appears.

 2. Select Category in the View by drop-down list.

 3. Tap Programs, and then tap Turn Windows features on or off.

The Windows Features dialog box appears.

Note 

You might be prompted to provide an administrator password or confirmation.

 4. Scroll to and select the Tablet PC Components check box.

Note 

By default, Tablet PC components are enabled in Windows 8.1 operating system. Therefore, the 
Tablet PC Components check box does not appear in the Windows Features dialog box by 
default. However, your system administrator might have modified the registry to display the 
check box in order to turn off Tablet PC components.

 5. Tap OK.

To turn on Tablet PC components in Windows 10 operating system

 1. Type features in the task bar search box, and then select Turn Windows features on or off.

The Windows Features dialog box appears.

Note 

You might be prompted to provide an administrator password or confirmation.

 2. Scroll to and select the Tablet PC Components check box.

Note 

By default, Tablet PC components are enabled in Windows 10 operating system. Therefore, the 
Tablet PC Components check box does not appear in the Windows Features dialog box by 
default. However, your system administrator might have modified the registry to display the 
check box in order to turn off Tablet PC components.

 3. Tap OK.



Chapter 6 Troubleshooting

smarttech.com/kb/171190 63

Troubleshooting the SMART Ink plug-ins for 
Microsoft Office

Windows operating systems only

If the SMART Ink plug-ins for Microsoft Office aren’t installed or working correctly, complete the 
following troubleshooting steps:

 1. Ensure the Tablet PC components are turned on (see Turning on Tablet PC components on 
page 61).

 2. If the Tablet PC components are turned on but the SMART Ink plug-ins are still not working correctly, 
make sure the SMART Ink plug-ins are enabled (see Enabling the SMART Ink plug-ins below).

 3. If the SMART Ink plug-ins are enabled but are still not working correctly, repair the SMART Ink plug-
ins (see Repairing the SMART Ink plug-ins on the next page).

 4. If the SMART Ink plug-ins are repaired but are still not working correctly, ask your system 
administrator to reinstall SMART Ink.

Important 

You might need to log in as an administrator to perform these steps.

Enabling the SMART Ink plug-ins

Note 

This procedure may vary depending on your version of Microsoft Office.
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To enable the  plug-ins

 1. If the floating toolbar is open, tap   in the toolbar’s lower-right corner.

OR

If the toolbar isn’t open, select SMART Ink Settings in the Windows Start menu.

Note 

This procedure may vary depending on your version of Windows operating system and your 
system preferences.

The SMART Ink Settings window appears.

 2. Tap Troubleshooting.

 3. For each plug-in that the SMART Ink Settings window identifies as disabled, tap Enable plug-in.

Repairing the SMART Ink plug-ins

To repair the  plug-ins in Windows 7 operating system

 1. Select Start > Control Panel.

The Control Panel appears.

 2. Select Category in the View by drop-down list.

 3. Tap Uninstall a program.

 4. Select SMART Ink in the list, and then tap Repair.

The SMART Ink plug-in installation wizard appears.

 5. Follow the on-screen instructions.

To repair the plug-ins in Windows 8.1 operating system

 1. Go to the Apps screen, and then scroll to and tap Control Panel.

The Control Panel appears.

 2. Select Category in the View by drop-down list.

 3. Tap Uninstall a program.

 4. Select SMART Ink in the list, and then tap Repair.

The SMART Ink plug-in installation wizard appears.

 5. Follow the on-screen instructions.
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To repair the plug-ins in Windows 10 operating system

 1. Type programs in the task bar search box, and then select Programs and Features.

The Control Panel appears.

 2. Select SMART Ink in the list, and then tap Repair.

The SMART Ink plug-in installation wizard appears.

 3. Follow the on-screen instructions.

Use the plug-in for PowerPoint after restarting your computer

After a computer restart, SMART Ink can take longer to start up  than PowerPoint. If you try to use the 
SMART Ink plug-in for PowerPoint immediately after you restart your computer, SMART Ink may not 
work correctly. When using SMART Ink in PowerPoint, follow these steps:

 1. At computer start-up, wait for all of your computer’s start-up programs to complete. This may take 
several minutes.

 2. Open PowerPoint. The SMART Ink Toolbar for PowerPoint should appear.

 3. Try using SMART Ink. If it does not behave as expected, close PowerPoint and wait a little longer for 
SMART Ink to start up.

 4. Open PowerPoint again and use SMART Ink.
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